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This presentation covers first the strategy behind Development Studio Client and is
then followed by a review of the Remote System Explorer in Development Studio
Client
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Then came CODE/400, in 1992 on OS/2 and in 1997 on Windows.
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Now, there is RSE in WDSc!
File Edit Source Compile Mavigate Search Project Run Window Help
B - ) oKk - | P a ] Ay B
2 1 Remote Systems - x “Welcome x PAYROLLG 2=/ outline ggj x
% =§ (§3 G Do | e -¢¢ Row 47 Column 1 Replace = @ Global Definition
B 5 — §....... E I D F S T a1 [Py Files
= erver 2
= f; series Obects ~—'|| Dozeoo C*  Housekeeping, clesr display fields and reA =13 Indicators
> P 004700 (G [+] *mso
-5 Work with libraries... "
4135 vWork with objacts on4snn c EZSR MATH ] [+] *INLR
4 2h Work with membere, 004300 C* If MAIN is done program ends + = Fields
& %Umw e 005000 c eval *INLR = *on = (s Main Procedure
o islb User libraries Q05100 * MAIN SUEROUTIMNE = % Subroutine:
i i‘IO My Library 005200 & MALIN BEGSR FE ACDESR
H Il RSELABOL.¥ib.test oos300 c dou *inke B3 ADDCDA
25 COMF;\RE‘*EIE pf-sri 005400 c EVAL *IN6D = TOFF & CHGCD
B} QUBLLESRC il oF-s1 LD . L33 EMESS = "ELANH E3 peLcog
+1-El) QCLERC e phsrc CLLED - e ENPAPL = *BLANH E3 eoims
= B QMDSRC, ¥l pf 51t 005700 G EVAL PRIAPL = "ELANE B2 EMPTA
55y QDDSSRE Al plsrc PO = EVAL RANAFL = "BLANH E3 vcoe
. 005900 c* & mam
=By QRPGLESRC *file.pf-s = B Frata
[ PAYROLL.rpgle ¢ a3 F'ERSNTA
[ PAYROLLG.rpale — — =
+-[Eh QRPGSRC *File.pF-src ‘
[+ i* i9eries Commands < |
: % i‘;’i':fe?bs » [, Library RSELABD1 (20 Ohjects) HES G D v x
< | = | | Mame | Type ‘ Attribute | Text | Status L)
= — PG CLLE debuggable, calls Payrolld, parm workstation num [s]4 —
Remate Systems | Team
ki PG CLLE debuggatble, calls Payrollg, parm workstation num [s]4
=] Properties *PGEM CLLE QK
Property ‘ Yalue iPGM CBLLE no errors OK 3
Atribute SRC i | l
Hame PAYROLLG -
Number of ... D Command |Nnrma| j ‘ j
Source RSELABO1 {QRPGLESRC Messages | E ‘ Shaw Lag... ‘
Status Ok o
< | ¥ Remate System Details | Tasks |iSeries Table Yiew | iSeries Commands Log

Today, we have the follow-on to CODE... the Remote System Explorer in
WebSphere Development Studio Client.
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WebSphere Studio Family
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Here you see that Development Studio Client is based on WebSphere Studio Site
Developer, while Development Studio Client Advanced is based on WebSphere
Studio Application Developer.

The Workbench is based on the open-source Eclipse technology about to be
discussed. It is not for sale, but is the basis of all IBM WebSphere Studio products,
and is available to business partners.

Site Developer is IBM’s entry level offering based on eclipse, and it is for building
dynamic Web sites out of non-EJB Java. Application Developer extends Site
Developer and adds support for EJBs. Application Developer-Integration Edition
extends Application Developer and adds support for JCA Connectors and for
Workflow. Enterprise Developer extends Application Developer-Integration Edition
and adds support for S/390 and Enterprise Generation Language (EGL), the follow-
on to VisualAge Generator.
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The Workbench is based on the open-source Eclipse technology about to be
discussed. It is not for sale, but is the basis of all IBM WebSphere Studio products,
and is available to business partners.
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There is now only one application development product sold by IBM, for iSeries, as of VAR5. This is
WebSphere Development Studio (Development Studio), which includes all four host compilers, all
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere
Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development Studio free
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development
Studio are priced very competitive compared to the combined prices of all constituent products. As of
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can be
purchased "off the shelf' from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have all the
modern Application Development tools from IBM. This ubiquity is especially important for business
partners who build and sell software. These Business Partners are now free to build software using
any of the technologies or tools in Development Studio, and can assume their customers will have
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively
raises the lowest common denominator to a level unparalleled by any other operating system.
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WebSphere Development Studio Client - Advanced
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RSM - Software Model

RMT — Manual Test

RFT — Functional Tester

RSA — Rational Software Architect
WDZ — WSED)



| IBM Software Group | WebSphere software

WebSphere Development Studio Client Advanced Edition 6.0.1
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There is now only one application development product sold by IBM, for iSeries, as of VAR5. This is
WebSphere Development Studio (Development Studio), which includes all four host compilers, all
traditional tools (ADTS = PDM+SEU+SDA+RLU+DFU+AFP+CGU), and unlimited licenses of the
workstation-based toolset named WebSphere Development Studio Client (formerly WebSphere
Development Tools).

If you are an existing customer who has a subscription, you can upgrade to Development Studio free
of charge. Without a Software Subscription, there is an upgrade fee. New licenses of Development
Studio are priced very competitive compared to the combined prices of all constituent products. As of
V5R1, there is no way to purchase the compilers or tools individually. So if you have RPG at V5R1 or
higher, you must have Development Studio and hence are entitled to Development Studio Client.

For consultants who do not have an iSeries of their own, but still wish to have the client tools,
Development Studio Client is also made available as a passport advantage product so it can be
purchased "off the shelf" from IBM Direct.

Development Studio has been a huge success, with over 80,000 licenses sold. Just as every
development machine used to have PDM and SEU, every development machine will now have all the
modern Application Development tools from IBM. This ubiquity is especially important for business
partners who build and sell software. These Business Partners are now free to build software using
any of the technologies or tools in Development Studio, and can assume their customers will have
the tools required to tailor everything from RPG to Java and Web user interfaces. This effectively
raises the lowest common denominator to a level unparalleled by any other operating system.
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@! Rational Software Development Platform Product Updates
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IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

11



‘ IBM Software Group | WebSphere software

WDSc Lite — Technology Preview

= WDSc Lite is a slimmed down workbench with only
the:
Eclipse workbench (branded as the Rational Software Development Platform)
Remote System Explorer
iSeries Projects
iSeries Integrated Debugger
= Requires only 256 MB RAM !l
= Optional installation feature for 6.0.1
Must already have full WDSc 6.0.1 installed
Creates a second copy of the workbench
= Fully supported technology preview

Preview of future packaging directions ©

i j I-*
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WDSc Lite — Installation and Startup
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Eclipse User Interface — Select Perspective

- : [ seect perspective 8
= Users work with perspectives e e
. . . Com onent: Test 2
—Collection of editor and views %cvsieposm S
~Tools for a particular task %EZ;Q
—Allows for role-based development %Egtmb
—Many perspectives are pre-supplied for g_lsnsta"iﬁpd_ati
specific tasks like Java, Web, XML, RPG/CBL  [3$ 1z ]
. . WJava
—Users can create their own perspectives B 1ava Browsing
kJJava Type Hierarchy
=l
= The user interface is very Windows-like o | concd |

—Eg: views can be re-sized and re-positioned
through drag ‘n drop

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

The core features of the Eclipse user interface include perspectives which is a
collection of views and tools. Perspectives allow role based development. For
example, if you are a Java developer you would use the Java perspective which
includes tools and views for Java development. You can also create your own
perspectives. Naturally, the Eclipse user interface applies to all Eclipse-based
products, like Development Studio Client.

14
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Eclipse User Interface — Perspective
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An example of an eclipse perspective... the active one contains the editors and
views you see. Other perspectives can be open simultaneously, but not active.
These are shown in the tray on the left, and can be made active by simply clicking

on them. To open new perspectives, use the Window pulldown.

15
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Now you know the story behind Development Studio Client. Lets look at the Remote
System Explorer, the tool for iSeries application development and maintenance.

16
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RSE Perspective — PDM Drill down, Filtered
Access

= [Series QSYS artifacts
libraries, objects, members, records, fields, modules, etc

= {Series Jobs
= iSeries IFS Folders and Files, and QShell Cmds
= Local Folders, Files and Cmds

= Remote Unix, Windows, Linux Folders, Files and Cmds
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The Remote Systems Explorer goes well beyond PDM! It also allows exploration of
iSeries jobs and commands, and the IFS file system. Further, it can also be used to
explore the file system of remote Linux, Unix and Windows systems. The Linux
support works for any Linux, including Linux in an iSeries Logical Partition.

17
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RSE Perspective

4P Remote System Explorer - Welcome - WebSphere Development Studio Client for, iSeries

File Edt Mavigate Search Project Run  ‘Window Help
5-EE8 Bk 5]
em E] welcome 3¢ 22 outline x
Expand to C
Y
Create new A | 0 outling is nok
This page tells y « - 9 U skark developing applications +—| javailable,
Development Sk Connect|0n *IJ read the sections below
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| S Get started [0 El
B Local... To know what B o ,
+-B Local the infarmation| Renvote iSeries System Connection
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Remote Syst
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18 I IBM System i5 Tools | Remote System Exploi et > | Finish Cancel orporation

When you first open the Remote System Explorer, you are not connected to any
system except your local hard drive on our workstation. To connect to a remote
iSeries host, you need to define a connection. In the Remote Systems view you
use the New Connection wizard to configure a connection to your iSeries host. You
can also use the Remote Systems view to explore the file system of remote Linux,
UNIX and Windows systems. The Local connection is pre-defined.

18
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RSE Perspective

4P Remote System Explorer - Welcome - WebSphere Development Studio Client for iSeries
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Subsystem: iSeries Objects
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After creating an iSeries connection, and then expanding it to the point where stuff
from the iSeries is to be shown, you are asking to signon to the iSeries. You can
optionally choose to remember the user ID and password, such that you won’t be
prompted again for them.
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RSE Perspective

&P Remote System Explorer - Welcome - WebSphere Development Studio Client for, iSeries
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Once a communication session is established with the target iSeries system, the
icons for the connection, and the nodes immediately underneath it, change to have
a small green arrow indicating you are connected. Of course, you also then can
expand to see resources from that iSeries.
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What is an RSE “Connection”? ! |
= Represents a remote system
Given an arbitrary name

Multiple connections to one system permitted

= Contains environment info
Such as library list and environment variables
Specified in properties dialogs of connection

= Used in many Development Studio Client for
iSeries tools

RSE, iSeries Projects, Java Tools, Web Tools, WebFacing

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

A very central concept to all of Development Studio Client for iSeries is that of

connections. A connection defines information needed to access a remote system.

Each connection is given an arbitrary name by you, and so multiple connections to
the same system are permitted. Each connection also captures information that is
applied when connecting to that remote system, such as the initial library list for
iSeries connections. All iSeries tools within Development Studio Client for iSeries
use connections to access a remote iSeries system. Connections are created and
managed in the Remote Systems Explorer.

21
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Working with RSE Connections

@ Bed oo w|HFvx
. =8 Mew Connection
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i l i5eries. ., %Opsn in Mews Window
E LDE FH Shaw in Table
Create connections here Rsfresh
(using wizard) e
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55 Copy
Change, rename, copy, Llc
delete them here bekre
4 Move Up
¥ Move Down
. Disconmect All
Expand them to work with Work Offine
resources here AREEIEEES
Remote Syskems | Team

IBM System i5 Tools | Remote System Explorer |

© 2004 2006 IBM Corporation

The Remote Systems view is the primary view for managing connections, via right

click actions. While this view is normally accessed in the Remote Systems Explorer
perspective, you can open any view in any perspective.
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iSeries Connections B |
. =E§ Mew Connection
= Connections expand to #-B Local
—“subsystems” = &b :1@; Server
—Named grouping of functionality gk SEHES Commands
ﬂ. iSeties Jobs
= Subsystems for iSeries connections: - Ty TFS Files

@ —iSeries Objects
—For working with Libraries, Objects and Members
—iSeries Commands

@ —For pre-defining and running QSYS command sets
—iSeries Jobs
—For working with jobs
—IFS files
9 —For working with Integrated File System files and commands

e l!
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Once connections are defined they can be expanded within the Remote Systems
Explorer. On expansion, the user sees subsystems, which are merely a functional
grouping of the various types of remote resources that can be explored in the
remote system

For iSeries connections, there are four subsystems:

*iSeries Objects is the PDM-like grouping, allowing access to libraries, objects and
members

*iSeries Commands allows developers to predefine command sets each of which
contain one or more often used commands. When run, all commands in a command
set are sent to the remote system and executed, and the results are logged in the
Commands view.

*iSeries Jobs allows developers to see various jobs, subsettable by job attributes,
and to perform a limited number of operations on those jobs

*IFS Files allows developers to explore folders and files in the Integrated File
System of the remote iSeries system

23
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24 | B S e ey | | Remate Systems | Team © 2004 2006 IBM Corporation

The iSeries Objects subsystem is the subsystem you will use most often! It is very
similar to PDM, in that it allows you to access objects in the QSYS file system, and
perform actions on those objects.
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When the pre-defined library list filter is expanded, and the connection is successful,
you will see the libraries on your library list. For each library, you can right-click and
select from a number of useful actions. There is an action to create a new source
file within the selected library, to refresh the contents of the library if it is expanded,
to rename the library, copy the library or delete the library. These last three actions
remotely run the appropriate iSeries command and you will see it logged in the
Command Log view.

If you expand a library, you will see all the objects in that library...

25



IBM Software Group | Web¢ @, =

Library Filter
Create a new iseries library filer
13 N "
Use “Work with XXX" [, — e e
) : Dbject Filter 4
tO C re ate OWn fl Ite rS Create a new iSeries object Filker %D
1l
= lee WRKxxxPDM! rary: Il = Erowse. ..
Object: [* = [E—
EE Remate Syskems v X Objecttyper  [* ﬂJ BRTo0
N €§9 o =§= Ohbject attribute: |* =1
- MNew Connection 4 ATNEED |
+ Local & New x
= '& My Server " —
= E eries Ohiach Member Filter *"
= :"F:D T Create a new iseries member filber $:>
+- 30 Work with objects. ., /
+- S Work with mambers, Library: M Eag| Browse... —
+ ﬂ Library list File: E =1 Browse...
¥ i}lb Userllibraries S B jJ B
+ ﬁ My Library ;
3 Eﬁ iSeties Commands Member type: ‘* jj Erowse. ..
+- 8 iseries Tobs Mare Typess> |
* ‘ED IF5 Files ¥ Source members [ Data members

| — | m

The three child items at the top of the list are for creating filters, much like in PDM:

-Work with libraries... prompts you for a simple or generic library name, and lists all
matching libraries. It is similar to WRKLIBPDM.

-Work with objects... prompts you for a simple or generic library name and simple or
generic object name, as well one or more object type and attribute pairs. It lists all
matching objects in all matching libraries. it is similar to WRKOBJPDM.

-Work with members... prompts you for a simple or generic library name, simple or
generic file name, and simple or generic member name, as well as one or more
member types which can also be generic. It lists all matching members in all
matching files in all matching libraries. It is similar to WRKMBRPDM. Unlike PDM,
the filters you create are permanently remembered and displayed in this list for easy
re-use. We will have more to say about filters. To simulate STRPDM's option 12,
you can start with the pre-defined Library list filter, that when expanded lists all
libraries in your library list. With any filter, once it is expanded you can subsequently
expand a library to see all objects in the library, and expand files to see all members
in the file. When you expand your first filter, such as the pre-defined Library List
filter, you are prompted for your password and then connected to the remote
iSeries. Then, the results of resolving the filter are shown...
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The iSeries Commands subsystem is merely a place for creating often-used
commands. The commands are created in a Command Set, which is simply a
named list of commands. By default you are only prompted for a single command,
but after creating the command set you can use the Change action to add more

commands.

Once a command set is created it appears in the tree. There are a number of
command sets pre-supplied by IBM. When a command set is expanded, the
commands in it are run and any messages are shown as children of the command
set. The commands are also logged in the command log view.

This is only one way to run commands in the RSE. There is also a Command Log
where you can enter commands just like a command line on the iSeries. You will
see that you can also create user-defined actions that appear in the menu for
selected objects and members, just like PDM user defined options.
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The iSeries Jobs subsystem is for working with jobs.

As with all subsystems, you can create filters (by right clicking on iSeries Jobs) to
see just the jobs you want to see. There are three pre-defined filters for you to see
all active jobs, only your active jobs and all your jobs.

The job’s icon indicates if it is active, done or queued.

Right clicking on a job allows you to work with the job.

28



| IBM Software Group | WebSphere software

@ Regp oo r|HF v x
. +-_% Mew Connection -~
IFS Files OB Lo GaTa v S
= " My Server .
+ ED iSeries Objects :ri?s:lmjith :
- . + & iSeries Command
For accessing . % sers o= | Supplied st
H = =] .
folders and files e filters =i
2! : |
Vi +- 5 oot file system .
Like WRKLNK 2 3 rome o namame | aCtiONS
v Create filters to see ——c Tl Jser —r=mgemm
. ; _ +-(37 deleteme | . %5 Copy
files in specific folders = G javastuff LTIET | o e
i i + -3 alfonso
(right click) =y % Delete
v'Use predefined Chain class Compile vl
H H i ile: (P Ly g
filters to drill down Consoelondass| oracrore
[4] consolero.java
‘/Open command DoMotHaveMain,  Compare With ¢
console (right click on DoNot:aver\rain. Replace With  »
. Dokothing,
IFS Files) for QShell oo proparies
I8 Hara rlacs 9
Rermote Syskems | Team

© 2004 2006 IBM Corporation

IBM System i5 Tools | Remote System Explorer |

The IFS Files subsystem allows you easy access to IFS folders and files.

Like all subsystems, you can define your own filters and there are some pre-
defined. In this case, the filters allow access to files within a particular folder.

Right-clicking offers access to a very rich set of actions you can perform against the
selected folders and files. You can even create your own user actions, as can for
the iSeries Objects and iSeries Jobs subsystems.

To run QShell commands, right click on the IFS Files subsystem object and select
the Launch Shell action. This opens a command console that is also very rich in
function.
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All iSeries subsystems allow you to configure properties via the Properties action in
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the connection is connected to the remote server.

© 2004 2006 IBM Corporation

A popular question is how to setup the library list such that it is set every time,
without manual intervention. This is where to do that.
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Now we drill down on the iSeries Objects subsystem, which is by far the most
heavily used.
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To create new objects, right click on a library to get access wizards for creating
some of the more popular objects for developers. Of course, you can also use the
command log or a command set to do this, but these wizards help by simplifying the
command.
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These are some of the right-click popup menus, based on object type. This shows
how rich the functionality is. Indeed, it is a superset of PDM’s functionality.
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The Properties view is normally in the lower left of your RSE perspective. It is where
common information about the selected object is shown, some of which is directly
editable, such as the Text property, which changes the text of the object on the
iSeries.

For a full set of all the properties, right click and select Properties from the bottom of
the object’s popup menu
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Shaw children of selected object in a table view

For libraries and files we can use a pop-up menu action to open table views to see
the contents of the library or file. In these tables, the columns are attributes for the
object or member in each row. The table can be sorted by an attribute by simply
clicking on the column heading.

The Show In Table action is available for every tree node that has children.
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When listing objects in a library, in a table view, you can turn on “Additional
information” to see more attributes: date-created, date-changed and size. Combined
with the sorting capability, this can be very powerful.

The same little pulldown menu has other actions that PDM users will be familiar
with.
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While there is nothing new in this menu, there is a PDM Options menu in the right
click menu from the table view, which shows all the actions by the numbers their
corresponding option was in PDM, to help with the learning curve of PDM users.



| IBM Software Group | WebSphere software

RSE Command Shell

B, Library RSELABOL (22 Obyj SEER o o B ow X
MName Type I Attribute | Texk I Skatus I e
[ElicLc1 *PiEM ° gable, calls Pavrolld, par.., Ok

CLR1 *PiaM =0 COEnTand, gable: calls Pawollgj par... 0K b
MY COMPILE #Pigh preSS nter Ok

PAYROLL *PGM *Use arrows to K

PAYROLLD Ril=le | retrieve Corn.mands ors Prompt Dk RUn
PAYROLLG *Pigh FFELE Dk y 2
= SeRAnARD FETI E ne She b

4 | 3
Carmmand INormaI j Iaddlible kesk j Brompt. .. | Run
Messages ILibrarv TEST added to library list, j Dekails.. . | Shiow I;og... |
Remote System Details |Tasks IiSeries Table Wiew JiSeries Commands Log

Show Log

My Server 1

addlible kest
Library TEST added ko library list,
Cause ... .. : If the ADDLIBLE command was used, TEST was added ta the user library list, IF the CHGSYSLIBL command was

used, TEST was added to the system portion of the library list.

2
| Command [Nerma = =

Remate System Details | Tasks (iSeries Table View I\Serles Commands Loql

Like PDM, there is command line at the bottom of the table, and it can be used to
enter command to be prompted and run. When run the results are shown in the
messages combo box, and the command log can be seen via the Show Log button.

Note that in 5.1, you can use F4 and F9 in this command shell.
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Cancel

Often we need to search through members looking for strings. To this from the
RSE, there is a dialog to help with it. It supports the same options as FNDSTRPDM
... actually more as it allows generic library and file names (as of 5.1). Indeed, this
actually ends up calling FNDSTRPDM to do the search.
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The result of searching is a hit-list view where the resulting matches are shown.

i
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IBM System i5 Tools | Remote System Explorer |
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They can be double-clicked on to open the editor to the line with the match.
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Here you can see that you can drag and drop files or copy and paste files across
multiple file systems, within the same connection and using the Remote Systems
view, iSeries Table view or the Command Shell.
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RSE: User Actions
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While IBM supplies a number of useful actions for remote iSeries objects, it is not
possible to supply them all. Like PDM, you can easily define your own actions. To
create your own actions, use the Work With actions in the popup menu for iSeries
Objects. These user-defined actions will appear in the popup menus for remote
resources. To avoid seeing all actions in all popup menus, you scope each action to
a one or more object or member types. You first define named collections of object
or member types, then you create your actions and scope them to one of these
named collections of types. You actions will then only appear for object or members
that match one of the types in the collection. If you are a CODE user, you can use
File->Import to import existing actions from CODE Project Organizer.

You can also create user actions for Jobs and for IFS (or local/windows/unix/linux)
folders and files.
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RSE: User Actions
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Here is what the dialog that is used to define new user actions looks like.

An action is a name (shown in popup menu), comment, command and a number of
options.

All PDM’s substitution vairables are supported plus additional ones. Use
Ctrl+Space, or press Insert variable, to see all the available variables.

Actions are scoped such that they only appear in the menus for the objects and
members they apply to. This is better than PDM allows. Also, you can specify if the
command should be prompted before running, whether to refresh the list after
running the command, and whether the action should only appear if one item is
selected, or what to do if multiple items are selected.
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Use your action you just created!
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N L
IBM System i5 Tools | Remote Sys,

Remote System Details | Tasks | iSeries Table View | iSeries Commands Log

Once your action is defined, you can use it. Right click on an object matching one of
the types you specified, and expand the User Actions menu in the pop-up. Your
action appears in the menu. Select it. If you chose to prompt the command, you will
see the GUI prompt for the command. When the command has finished running, it
results are logged in the Commands view.
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Remote System Explorer

Editors

i ] 1 A

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation
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Editors
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For a source member, there are two options for editing:

1. Remote Systems LPEX Editor. This is the new editor, written all in Java, that is
built-in to the IDE. It is a re-write of the original CODE Editor, but as you will see

has a subset of the functionality in CODE at this point.

2. CODE Editor. This is the classic full-functioned CODE editor, which is offered as
an alternative until the Lpex editor catches up to the functionality of the CODE
editor. This launches the CODE Editor in a separate window.

We will cover the Remote Systems LPEX editor next in more detalil...
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LPEX (“*JLPEX?”) built-in IDE editor
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The Remote Systems LPEX editor is built-in, so it shows up in a pane within the
IDE. You can open multiple members for editing, and each will be shown in the
editor area with a tab that when selected brings that member to the foreground. You
can double click on a tab to expand that member's edit window to full size. When a
tab shows an asterisk in it, that indicates there are pending changes that should be
saved. For RPG (both Ill and 1V) you will notice there is color highlighting and
familiar F4 support to prompt for the current line. The prompter sits is a view that
doesn't overlap the editor. When done filling in the prompt, you can press one of two
buttons to replace the current line or insert a new line.
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Same source
T I member, multiple
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LPEX Editor Functions: Edit pulldown

'ﬁ’ Remote System Explorer - PAYROLL - WebSphere Development Studio Client Advanced Edition for iSeries
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This shows the Edit menu, when the editor is open and in focus. This menus offers
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actions for clipboard, searching, selecting and a number of cool tools.
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This is the Source menu when the editor is open and in focus. It has a number of
actions that apply to the entire source member, as opposed to what is selected.
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LPEX Editor Functions: Context menu
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Here we see the pop-up menu within the LPEX editor. This contains clipboard and
selection actions, as well as filtering actions which we will discuss.
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There are a number of other interesting Editor capabilities available for enabling in
the editor’s preference page. The most exciting of these are the column-sensitive
editing and the highlight current line option. The former allows editing within a range
of the RPG/DDS spec such that other areas of the same line are not affected by
insert or delete, while the latter highlights the line containing the cursor.
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LPEX Editor Functions: Preferences
) L i
s r - Language-specific editor preferences

o @ aencsmsied - Enaple auto syntax checking Enable auto

E] e I Autgmatic uppercasing R B
e b b uppercasing
E;E'::; ¥ Repsat previous specification type E k

B InstalljUpdate I™ Repeat previous operation cade (if on C-Specification) nter ey

- Internek ™ et C-Specification cursar position 5

@ B e ’ behaviour |

- Java ™ Set free form C-Specification cursar position

-Logging Position B

- LPEX Editor

B
- Plug-In Development I™ set D-Specification cursor position
- Prafiling and Logging Pasition [Fom =]
E-RAD
Readme Example ¥ Automatic indent Blanks (1-z0): |2
Er-Remote Systems ¥ Automatic losure of contral black Stoles [enomn =

Communications

"“E:::SCEC*'E P I~ User defined tabs Tab key

-iseriss | ] =

Go — behaviour

-Command Executio
Command Subsyste = B &
- Job Subsystems
£ LPEX Editar Parsers and ez |
<3
COBOL
o0s

RPG/400 -
“ 5 Restore Defadlts Apply |

e [ canel_|

In addition to preferences that apply to all languages, there are preferences that
apply specifically to individual languages.
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Autosave

workbench Al LPExEditor |
- Agent Contraller
~Ant V¥ Autosave
Build Order
- Help
T LaijUpdate
- Internet
- iSeries Projects
JZEE
~Jdava
Logging
- LPE® Editar
- Plug-in Dewvelopment.
Prafiling and Logging L
-Remote Systems
* Communications
Debug
File Cache:
Files
iSeries

Ly
ogaing Restore Defaults I Apply
co |

Minutes between saves (1 - 60) | 2

Autosave

preferences

© RSLE0100Q

), Alocal backup copy from 24/01/06 3:12 PM exists for the source you are Dlalog When Openlng a
opening. This occurs if your previous editing session ended abnormally.
=2 iould yeu e to opan Eho backip copy i the odkar? member and autosave
Tes Mo | et | backup exists

W
IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

54



| IBM Software Group | WebSphere software

SEU Style Prefix Commands

= SEU common prefix commands
= ILE RPG Format Line prefix commands
= |LE RPG Prompt prefix commands
= OPM RPG prefix commands
Example:
1,15, D, DD ...etc.
FD, FC, FO, PP ...etc.

PH, P?, PC, PO, PP ...etc.
F, F?, P, IP,IP? ...etc

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

You can configure the LPEX editor to adopt the keyboard and command
personalities of many popular editors. Most editor profiles differ only in the keys and
commands used to perform various editor tasks. Some base editor profiles, listed
below, also add a prefix information and command area at the start of each line:

ispf
seu
xedit.

The editor recognizes prefix commands used by these editor profiles. Depending
on which profile you are using, you can enter SEU, XEDIT, or ISPF commands
when the prefix area is active.

By default, the SEU profile is the active profile.
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Getting More Editor Space

= Double-click on any Workbench view or Editor tab to
maximize the view or Editor window

= Views can be dragged around and stacked into
tabbed notebooks

= Views can be dragged to the left hand side of the
Workbench as Fast views
— Single click on the Fast view icon to open the view
— Click Fast view icon again to close the view
= Oh — oh, what have | done?
— Window -> Reset Perspective

R L @

| IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

You can easily double click on a view or editor tab to maximize the view or Editor
window. If you double-click again you will return the view or Editor window to its
original size. You can easily rearrange views by selecting hem and dragging them
to another location in the workbench. If you are going to use a view frequently but
don’t ant to see it all the time in the workbench you can make it a Fast view. You
select the view, right click and select ast view. The view will then appear in the left

hand frame of the Workbench as a Fast view icon.

To reset your workbench window to its original layout, you can select Window ->

Reset perspective.
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4P Remote System Explorer - PAYROLLG - WebSphere Development Studio Client for iSeries
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Here you see an example of the Remote Systems view and the Outline view as
Fast views in the workbench left hand frame.
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The Outline view helps you visualize the member you are editing by displaying all

the program structures and functions in a clear-cut view.
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YARYING =2 NOOPT
[ I t n
==
The WARVING kevword indicates that a character, graphic, or UC5-2 wec PERRCD(HUMERIC-CONSTA se ec Io
field, defined an the definition specifications, should have a w2 PROCPTR
vatiable-length format, If this keyword is not spedfied for character, (173 sat1e
graphic, of UCS-2 fields, they are defined as fixed length. = TIMFMT(TIME-FORMATITIVE-SEPARATORY)
o TOFILE(FILE-MAME)
Ed -
004300 C* determines if the prograwm o | 4
004400 C* update an existing record in the file.
004500 P T T ]
004600 C* Housekeepinco 1 a- di=p] field a1 t indicators.
Q04700 G
004500 & & g
oosson o 1= mm o | Available for COBOL in -

5.1 and later

The Content Assist tool offers not only auto-complete functionality, by giving you a
list of possible functions, objects or keywords to use, but also offers documentation
on each of these to help you decide.
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Help — at your Fingertips

RPG, Cobol, DDS
online references

Programming Guides

including CL
F1 Help

Sensitive to where cursor

is in the editor

Message Help
and much more

# Help - WebSphere Development Studio Client Advanced Edition for iSeries

Search: E Search scope: iseries

Contents oz}

iSeries programming information

@ iseries application develupeﬁ
iSeries programming inform.
= 6B High-level languages
B PDF wersions of the books
B cjc++
03 coroL /400
=83 1E cosoL
L8 L anguage Reference
L2 programming Guide
B Java
(3 ppi/a00
EMEILE RPG
= Language Reference
(B Contents
B RpG IV Concepts —
(B8 Definitions
=08 Specifications
8 shout Specifica
L8 control Sperific
iption|
B File Descrin

IBM System i5 Tools | Remote System Explorer |

WebSphere(R) Develop
Reference

File Description Specifi

File description specifications identify each file
must have a corresponding file description spe

Afile can be either prograr-described or extery
record and field descriptions are included withi
specifications). Externally described files have
externally using DDS, DSU, IDDU, or SOL co
praduct.)

The following limitations apply per program

» Only one primary file can be specified.
required.

& Only one record-address file.

» A maximurn of eight PRINTER files

» There is no limit for the maximum numb

[ Top of Page | Previous Page | Next Page

© 2004 2006 IBM Corporation

Now you can have a ILE RPG reference at your finger tips. Simply press F1
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Instant syntax checkinag

2% outline @ x
1 L 54 Column 28 Feplace 2 changes. = %G\obal Definitions
Errors InsertEd as ShOW ..... CLONO1Fantor L+++++++0pffade (E] +Fantor 2 +++++++Reaul [y Files
lines” when cursors ~ ps * EAIN SUEROUTINE Al =G mdustors
. 0 C MAIN BEGSE +-f— Fields
moves Off ||ne 0 C dou *inko ! | = G Wain Procedure
¢ EvflL #INED = *OFF + L& subroutines

FENFSO14E Operation code is not walid: specification

c EVAL EMESS = *BLANK
Press F1 on error to get [ ; EUSL EPARL - mLAW
2nd_|eve| help C EVLL RSNAFL = "BLANE

o

C* Irite the SELECT format to display. If end

4P Help - WebSp. =re Development Studio Client for, iSeries

Search scope: Al topics

€ s 2l S
RPG Messages

Search;

Contents

& iSeries application develop@Ry

€ iSeries programming informati)

0 Remote System Explorer Develo
0 WebSphere Application Server Ny
@ 125E SDK 1.3.1 APIs RNF5014
% Tool developer information
% J2EE SDK 1.3.1 APIs

Cperation code is not valid; specification is ignored.

% Remote System Explorer User G an
@ support information Cause . .- The Operation code is not valid. Mo further checking is done on the
wWeb developer information specification. The operation must start with a valid Operation Code and can be

followed by an optional Operation Extender. If specified the Operation Extender must
be one or more of A, D E, H, M, N, P, R, T, or Z, and enclosed within parentheses

Recovery : Specify a valid operation, or omit the specification. Compile again

| < | #||| [Top of Page | Previous Page | Next Page | Table of Contents ]
61 1BV 54 ﬁ m] Copyright 1B Corporation 1992, 2003, All Rights Reserved.

The Remote Systems LPEX Editor gives you instant feedback for your code, at the
location where a syntax error occurs. This happens as you cursor off a changed
line.



s S Bl TR - TS B ST el of the compiler =
File Edit Compile Mavigate Search Project Run Window  Help
|65 - [ tew P*.ﬂ.“&“*&.@-c{>-]@f§|ﬁ|II‘|AE}[?$
ot [pge Conest - x x] 8= outine & x
| Prompt
qa N B Row 56 Colwmn 4 Ingert =& lobal Definitions
Synikax Check Al - . ... cLONDIFaztar 1+++++++0pcode (E) +Extended-factorz+ | @ [ Fles
- §
9 37 || posioo * MAIN SUBROUTINE Al (3 Indicators
B 005200 a4 MLIN BEGSE F= Fields
? 005300 c dou *inke EQ?‘! Main Procedure
Select Format Line. . 005400 @ EVAL *IN&O = ¥OFF 1 C& subroutines
Show Indentation 005500 ® EVAL EMESS = "BLANK
==
P | bosrn - O e
JCOPY Member 3 B
005800 ® EWVAL RBNAPL = #ELANK
Resequence All Lines 005200 CT
Refiesh st b Program Verification Optio =
< Listing | Listing ‘
o Data .
- Defines ¥ Generatz lsting
o POML T ghow cross references
G- I show COPY statements
I™ show DDS statements
I Show external procedures and fields
Lines per page: B0
Source listing indentation: | *MNOME -

R

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

Use the Source pulldown to verify your work. The verifier is a built-in copy of the
compiler, for the purpose of catching all errors, not just syntax. The verify has
options, which effectively are the subset of the compiler options that affect error
checking.
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Verify — Error List

&P Remote System Explorer, - PAYROLL - WebSphere Development Studio Client for iSerjes

File Edit Spurce Compile Mavigate Search PBroject Run  Window Help

-BR a8 -t-a%-[|s]ve-=>-|a6 mmr Al E
=] U8 Remote Systems v X /PAVROLL X 1 B2 outline S§3 x
’E Xegh o @ | " 4 Row 365 Colwmm SO Insert = Giobal Definitions
] ?9 User libraries & "CLOL I+++++++0pcode (E] +FaotorZ+++++Hge sul ottt [P Files
= H iib My Uibrary =| o3esoo MOVE ERR (2} [EHE S| A E{:_‘, Indicators
EI!-I% T = operands ERR and EMES have types that are not | == Felds
E] COMPARE. *ile.pF -sre : name or indicator EMES is not defined. E%Mam PFGEEd.LIr’E
S GCRLLESRE Hie.pi-sr 036600 ELSE 08 Subroutines
) QCLSRC *Fie ph-src 036700 HOVE o +INED
[y QCMOSRE Hile.pf-sre I ElE

[Ely QoSSR *file. pf-sre I
£ Ely QRPGLESRC.*file . pf-s .
- By PAYROLL.pgle
-y PAYROLLG.rpgle
Ely Qrpasre. Hile pf-sre
L& iSeries Commands

Double clicking on
error takes you to

following IF AND combination ensures that at |
ilication has heen selected. N

L[
o

TF300.NFAPL IFEQ ot
] i |
Verify progrsm action completed with errors.

|
]

e Rl

. Message | SE | Line: Location | Cor# |
error In source 5w x || dNs1ay Factor 2 must be '0f or ‘1" when the Resultis ani.. 30 384 RSELABDLJGRPGLES.. My
[»| | $INESE T 5 ERR and EME . a0 | RSELABOL/QRPG
Attribute SRC _ || i RNFFOED RPG provides Separate-Indicator area for file M... 0 27 RSELABOL/QRPGLES... My
Marne PAYROLL i RFrost The name or indicakor RSMTAG is not referenced, O 110  RSELABOL/ORPGLES.. Mv ¥
humber of ... 0 S u I 2|
Source RSELABO1fQRPGELESRC + | | Remote System Details |Task5 |iSeries Table Wiew |i3eries Zommands Log | i3eries Source Prompler l\Seriss Error List J

W J ¥ |

IBM System i5 Tools | Remote System Explorer |

© 2004 2006 IBM Corporation

After performing a verify, the Error List window lists the errors that are found and

their severity, inserts the error messages directly into the source and helps you to
navigate between the errors.
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Listing View

4 Remote System Explorer - PAYROLL - WebSphere Development Studio Client for iSeries

Flle Edt Source Compile Mavigate Search Project Run  Window Help

5-HE& || #-%-&-|s[%c-o-

|Jas | mmr|AEE

= U Remote Systems v x || Fravroll x ] 22 outline @5 x
=) I IO | w Row 368 Column 26 Ingert = % clobal Definitions
— 'actarl+++++++!pcode (E) +Factorz +++++++Result+++++ Files
ez} i+ i User libraries A i
iy ; 2| ozss00 END A (3 Indicators
— =1 g My Library L e
" 036900 = Fields
= Il RSELABO1.*ib.test o 1
. 1| = G Main Procedure
Ep COMPARE.*file pf-src & I ] ] & subroutines
) QCBLLESRC. *file pf-st Verify program action completed with errors.

By QrLsRC #File,pf-src
[Ehy QrMDSRC.#file. pF-sre
[E) GDDSSRE *file.pf-src
= =) QRPGLESRL file.pf-s
[y PavROLL.rpgle
Oy PAYROLLG.rpole

[E) GRPGSRC *file.pf-src
+- &k iseries Commands s
N 191 CrTrTTrr R T T T E R T T T AT T TR AT T T TR AR T T AT RRRTTRTTRRR LT -~
) i iseries Jobs Lo )
1 % IES Eil 192 C*
~| . B 1
i 193 C* Housekeeping, clear display fields and reset indicators. —
Verify with Prompt > s oo
1
SeleCt Generate @ IEN WebSphere Dewvelopment 3tudio Client for iSeries PALYROL:
v X
Listing - Line <= —- Zource Specifications
= Nunber ... [ N T TS NI PO
T FATROLT = 5 m ]
Mumber of ... 0 —
Source RSELAEBDL/QRPGLESRC w | | Remote System ... |Tasks |iSeries Table Wiew |iSer\es Cornrmand. .. |\Series Source Pro.. ‘iSeries Error List I\Series Listings J]I

S 1T

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

Here is the Listing view from the Program Verifier, if that option was chosen.



IBM Softwar 4 Create Bound RPG Program (CRTBNDRPG) E
-~

Program: A YROLL - Mame
Library: ,Wl Marne
R Source file: QRPGLESRC - Mame, QRPGLESRC
C o m pl | e Library: ,Wl Marne
) Sourcs merber: [ r— Hme
W I t h Generation severity lewel: ,107 0-20

Text 'description’s | #SRCMERTRT j Character value...

p rOI I I pt Default activation group: *YES -

Advanced Parameters

Compiler options: -

HFEVENTF

HAHS

Debugging views: #*SOURCE -

hd
a4 &3
™ advanced () [~ all Parameters(¥) ™ keywordsiZ)

CRTBNDRPG PGM(RSELABOL/PAYROLL) SRCFILE(RSELABO1/QRPGLESRC) SRCMBR{PAYROLL) OPTIOMN(*EVENTF)
DEGVIEW(*SOURCE)

OK I Restore defaults Cancel |
5T

When you select to prompt the compile command, the command prompt is
converted to a GUI and displayed. For the 5.1 release, this GUI was re-written from
Java’s Swing to Eclipse’s SWT so it more consistent with the rest of the dialogs in
the IDE.




IBM Software Group | WebSphere software

Complllng = | [ 18 emote systeme Efy CRTRPGMOD

R EEENES AR ol Iy Tt
= To compile a member, |2

use Compile pulldown
when editing, or right-
click menu on the

036900
037000
037100 C* agpplication has been sele
037200 cr
037300
037400
037500

+- [ EfCoMPARE #file.pf-src

+1 ) QUELLESRC . *file.pF-sr

Ehy QCLSRC.*file p-sre

+- By QCMDSRC #File.pf-src
=l ~orccon P

member 4 Work With Compile Commands
Parent prfile: [Phil ~|
Member bype: RPGLE - Add..

Choose from existing
compile commands
or

Create or Modify @—
compile command

Compile Commands:
Selected compile command:

Mew cornmand

CRTRPGMOD Label: |
Command:

RTEMDRPG PGMBO M) SRCFILE(RL [&F) SRCMBR.(3N) F

& I 2
Insert veriable. . | Edt... | Browse... ‘
Prompt...

. Close:
IBM System i5 Tools | Remote System Explot g

After you have verified and fixed all your errors, it is time to launch the compile. This
is done via the Compile pulldown (only if editor is active) or the member’s popup
menu. There are a number of compile commands pre-supplied for you, for each
member type, or you can create your own compile command. Like user actions,
these support substitution variables. Once you create a compile command, it
appears in the cascading Compile menu.

The last-used command, for this member’s type, is checked in the Compile menu.
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Run: from popup menus

=

Run from Popup menu of 5% = [« :
*PG M i\: r::;‘Connectlon b
v'iSeries appl. in RSE job e s £ s Tl
¥ Batch it Pl
v Interactive 2 & vorcnthneniers | Gl
v M u |t|-th readed -, Q5v52924 ib.prod-sy: @ Rename

Il Q5VS.¥ib.prod-sys

Wy Csvs2. Hib. prad-sys See

-l QHLPSYS. ¥lb.prod-sys I reste
B, QUIRSYS. ib.prod-sys e Mave

RU n AS i QGPLMib.prod-ust

M QTEMP b testusr | W DSt

Update...
Change...
Save..

Run(Prompt)

Restore..,
User Actions 3

Service Entry Point »
iSeries application in RSE Job
Batch

EMPMST. *file, pf-dt.
EWFEWEMT. *file pf-c
B} MSTDSP. e dspF

B M5TDSPZ  *file. dspf

4 Properties

RuniPrampt)(F)
Debug As(J) 3
Debug (Prompt)k) » Multi-threaded

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

You can run programs from the Remote Systems view or the iSeries Table view in
four ways:

In the RSE communications server job
*In a batch job

*In an interactive job

*In a server job

In the first case, running the program in the same job as the Remote System

Explorer communications server job,will tie up that job until your program ends. With
batch and interactive jobs, you cannot monitor the status as easily, however, you do
not tie up your communications server and you are notified when the program ends.

Batch jobs work as you would expect, your application will be submitted to the
default batch subsystem.

Note: A multi-threaded debug session creates a new server job and this way keeps
the RSE communications server job free for other tasks.

67



File

4B Remate System Explorer - WehSphet
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Run Configurations: for easy re-use!

tﬁ: Remote System Explorer - WebSphere Developn

File Edt Mavigate Search Project Run Window H

B

Run &s 13

@ o e u
J; News Connection
B Local
B My Server

&y iseries Objerts
28 wiork with libraries...

2 wiork with objects. .

2 work with members. .

- Library list

w-lfll ©5Y52924, M, prod-sys
il Q5¥s.¥lb.prod-sys
il ©5v52.%ib.prod-sys
#1-Jffl, QHLPSYS.#lib. prod-sys
Wil QUSRSYS.Mib.prod-sys
-, QEPLAib. prod-usr
i, QTEMP. b best-usr
ELAED4, *lib.prod-usr

CLCL.*pam.clle
CLR1.*pagm.cle
MYCOMPILE. *pgm.clle
PAYROLL. *pgm.rpgle

FROLLG *pam.rpr +
COMPARE. *file. pifc

velopment Studio Client Ad
Edit Navigste Search Project Ru

o

Create, manage, and run configurations

Canfigurations: Bame: | My iSeries program for run

By Compiled Application
58 15eries: Run Application i

E iseries: Run Batch Appiic How To Start | #5 Common |

Connectian: [y Server

B Mew_configuration
% igeries: Run Multithread
28 Java Applet

Command ta start application:
CALL PGM{RSELABO4/PAYROLLG) =

4 Java Applcation

B 2ava Application in ISerie
), JavaBean

gy it

@ Runrtime Workbench
~{} Seript Host Application
Server

- E3 websphers v5.1 Applica
538 websphere w5 Applicatic

Prompt.. |

Anply Revert

PP Close

=35

=

Hi

Existing run configurations are easily

accessible in run pulldown!

Run configurations are for powerful re-use. If what you want to run a program that
takes a number of parameters, or is not straightforward to launch, you can predefine
this information into a named configuration. Once created, the configuration
appears in the configuration list, and can be selected from there. Every
configuration run also appears in the pulldown menu of the Run tool bar button.
Clicking the Run tool bar button itself, will run the previous configuration again.
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Jr_’i.E Mew

Indent View

File Edit | Source Compile Wavigate Search Project Run Window Help

HollamAtce-2-es[mme|ad RS

Prompt F4

il x
,E Syntax Check all Column 12 Replace 1 change.
......... i - Eefoocrlon onesn ooklon oo SE P B o aEe BEn DR et SR o alEn Do R R ..
ﬁ EX verfy ChrlShift+Y 006000 C# TWrite the SELECT formwat to display. If end of job recuested, 4f
Wwerify with Prompt... 006100 cw
006200 c* =
Conwvert All To Free-Form 006300 c o not *IN6D
SSiect hormnakLne Ty 006400 c EXFNT SELECT
006500 c *INKC IFEQ 1
Shov Fizlds a e E
JCOPY Member » c ELSE
pe— R c EXSR EDITSL
c END
Resequence All Lines c*
Refresh RS C® IF the general error indicator *IN60 is on (equal to 1), the

I, QGEPL.*ib.prod-usr
-lif, QTEMP *lib,kest-usr
=iy, RSELABO. *lib. prod-usr
CLEL *pgm.clle
CLRL. *pgm.clle
MYCOMPILE *pgr.clle
PAVROLL *pgm.rpgle
PAVROLLD *pgm.chlle
PAVROLLG *pgm.rpgle
COMPARE. *file. pf-src
EMPMST *file pF-dta
EWFEVENT *file pf-dta
MSTDSP *file. dspf
MSTDSP2. Mile. dspf

kil

ol

= iseries Indent

Remote Systems | Team

[ Properties

Propert: [ value

Attribute  SRC

Here you see the results of the indent option: a readonly view showing the code

Row 629 Column 12 Browse
- 2 3 4 5
C* TWrite the SELECT format to display. If end of job reguested,
o=
o=
c I | Doy not *INGD
C | | | EXFHT SELECT
c *INKC I | | IFEQ 51
C I | | | LEAVESR
c I | | ELSE
C I | | | EZSR EDITSL
[+ I I | END
o=
C* IF the general error indicater *IN6O is on (equal te 1), the
4
ote - plore 004 2006 IBM Corporatio

indented, much as it is in a compiler listing, but with color.
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Show Fields

&b Remote System Explorer - PAYROLL - WebSphere Development Studio Client Advanced Edition for iSeries —18 x|
File Edit | Source Compile Mavigake Search Project Run  Window  Help

¢||AAB|cc-2-]|26 | 5BEr|AY LEKEER

-

= - E

W@ Promet R4 x| Outlin X
Syntax Check All 27 Coluwn 9 REeplace 1 change. €§3
..... FFiEname++IPEASFRlEn+LKlEn+AIDEvicE+. Kevwords++++++ E--% &l

R

= (B VeriFy Crbtshift+¥ o F* ACDESR — Edit action code for all maintenance |=|
Werify With Prompt. .. no R L R R LR
no F* This program uses all externally described £il

C t &l To Free-F
armeer o Fresstarm no F* used are - M3TD3FP - maintenance display file

no F* - EMPM3T - employee master file

a F* - PRIJMST - project master file

=) F* — RSNMST - reason code master file
i e T T T Y

Select Format Line. ..

Show Indentation

TCOPY Member

ILE RPG Help \ , no FHSRDSE CF E WORKSTH
[u) FEMPMST UF 4 E E DIZE
Resequence Al Lines 0o FPRIMST UF 4 E K DIZE -
Refresh Chrl+F5 | _;l_l
m EPL, ¥ib. prod-usr \
W, QTEMP b, test-us | ‘ »
RSELABO4.*lib. pros
] CLC*pgm.cle E File MELABO4{MSTDSP (71 Fields) &9 x
(. (] cLRL*pgm.clle (| Hame | Record | Type [ Length [ Text =
O el ’_,*i_l = *noa SELECT Character 1
Remote Systems JTaam o= ramios SELECT Character 1
It*msu SELECT Zharacter 1
[ Properties ,E:::, v x F=ErMparL SELECT Character 1
Propert: | value - Ii:PRJAPL SELECT Character 1
ﬁ_DanDI SFIFCT ~hararter 1 il
Attribuke | SRC 4| | »
Hamf AL - | | Remote System De... | Tasks |iSeries Table View | iSeries Commands ... |iSeries Source Pro., liSerias Field Table ...

r

| IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

Here you see the results of the Show Fields tool. It retrieves the fields for the file
under the cursor, and shows the fields in a table view.
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| BX @ undo iz |#lwe-9-]/26mmr|AgE
|| & Redo Chrl4y 52/ Outine & x
’E :{’Cut Chrl4y Column 1 Insert =& Glohal Definttions
2co%ooooflococtocooBooootFoccaBonootocoafioanotfacad
| & copy et I oosaoo & eval *INLR =
— @ Paste Chri+y oos5100 F MALIN SUBROUTINE
[nluftedulul © MATH BEGSR
% Delete ':m C dou * INKC 1+ subroutines
Select Al Chrl+A fc—sr 005300 C dou *inkc
005400 © EVAL *INsO = *OF
AR, G fsre 005500 C EVAL EMESS = *BL
Rt Gt i 005600 c EVAL EMPAPL = *BL
Find Previous Chrl+U [pf-s oos5700 © EVAL PRILPL = #EL
Find Other 4 el = || oossoo C EVAL RSNAPL = *BL
Show Al gl 005500 ct 3
Add Bookmark..,, | i I 3|
add Task... One or more mjBwatches found.
Select » 3 e I
Selected [ E File RSELABUIL!NMST (6 Fields) (§3 x
Deselect Ale+u Mame l | Record | Type | Length | Text [ |
Mark, » q:ACREC RCRSM Character 1 ACTIVE RECORD CODE =
e — h Character 8 REASON CODE |
Keystrake Recorder e H Character 50 REASON CODE DESCRIPTION
Conbent Assist CHI+SPACE R Packed D?ﬁmal 7.1 REASON CODE HRS CLIRR I‘VIONT}H ~
durber of ... 0 Refresh Compare  Chrl+Shift+R
Source RSELABO1QRPGLES Cloar |iSeries Table View | iSeries Commands Log | iSeries Field Table view
T T T

o

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

The compare tool under the Edit menu is used to compare the currently active
member in the editor with another member you select, and the differences are
shown within the edit window, as we see here.

Alternatively, there is another compare utility not editor based, in the popup menu
for members.
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| te Il g Right click in editor
x| to filter view
Row 66 Column 17 Rep la . -
..... CLONO1Factoll+++++++0pcode (E) +FRcCLOLE+++ Only Ilnes meetlng
005900 1 1 1
oo&000 Syntax Check Selection rmat. to display. fllter Crlterla are
0oe&100 Convert Selection To Free-Farm
ooszon o shown 7 Use+/-to eXpand
006300 not *INED .
ooswn | oy m sELECT or collapse filtered
006500 Paste Q T a
006600 — VESR sections
006700 e E
008500 R R ELITSL I
006900 SR e Fou 446 Column Insert
007000 el i’ B. ... cLoNoffactor 1+++++++0poode (E] +Factors ++++]
007100 Deselect r indicator *INED A
007200 po— By DA, ] H ooszoo c MATH EEGSE B
gg:igg Shauy &l Cade | endsc
H RSNTAG BEGSE
007500 Save EZ:::‘MS m| ENDsE
007500 ) ror c EMPTAG EEGSE
a07700 Add Breakpoint: Procedures . d
el 5L Statement: | c ENDRR
oo7e00n C*¥ that application. ST H C FRITLG begsr
007900 C*  If ENPAPL [ewployve | o - endar
ooso0o0 C* branches to label M c EDTTEL BESSR
H c ACDESE BEGER g
H c ENDSE
M c ADDCDE BEGER
c ENDER
ﬂ 044400 c CHGCDE BEGER
c
044600 c

A very popular feature of LPEX is its support for subsetting the source to show only
lines meeting a criteria, such as containing a given string or representing the begin
or end of a subroutine / procedure. This capability is accessed from the right click
menu of the editor. In subset mode, you will notice plus signs, that if expanded will
un-hide the lines up to the next visible line.
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& RPG Procedure Wizard

RPG Procedure

Create RPiG procedure aﬁl

New Procedure wizard

R ocedure bype: ISubDru:edure ;I

Procedure name: I ma

External name (EXTPROC): I Maimurm

Row 1 Column 1 Replace Purpose: I determine maximum of two numbers
P | R L-EEE TS SRS
ooo100 Frmn e a A A A AN TR AAAAAATAAAANT ¥ Exportable for use with other code (EXPORT)
Qe F7 PROGRAN NRNE - Payroll I Generate free-form calculations
ooo300 F* DESCRIPTION ki
ooo400
0ooso0 Parameters created for this procedure;
000s00 Contest Mame | Type Text
000700 Prompt Firsthbr Integer
[nlulut=inln] Syntax Check Line error condit secondhbr Integer
ooosoo Select Format Line... dizplay on c
ooio0o0 | Job reguestec
Procedure wizard = : =
generates Add. .. Change.., Remove Move Up Muove Down
prototype and I Pass the operational descriptars with the parameters
bOdV StUb ¥ Return a value

= Back [ext = | Einish I Cancel

IBM System i5 Tools | Remote System Explorer |

© 2004 2006 IBM Corporation

In 5.1, the Procedure SmartGuide from CODE/400 was ported to the new editor.
This will prompt for a procedures signature information (name, parameters and

return type) and generate the procedure prototype and the body. It is up to you to
subsequently add logic to that body.

The prototype is generated at the top, after the last D-spec, while the body is placed
at the bottom of the current member.
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& Change Procedure Parameter,

Parameter name: | Firsthbr

R Parameter description: I
New Procedure wizard | s

™ Defined like another field: I
& Eield = Data Structure = Record Format

Length: ls— 3,5, 10, 20
Decimals: lD—
Procedure wizard Thedmsofthecte [

helpS Wlth I~ CEaID number: *DFT 01- 65535, *DFT

complexity of RPG paTrTy | o

Separator |
language !
Sample; I
Array entries (DIM): I ‘
"Other keyword
I~ aLTSEQ I~ ASCEND I~ DESCEMD ™ HOoRT ‘
Flyover help
descrl bes each Parameter passing options
. [r Pass copy of contents {WALUE) ¥ Pass read-only reference (CONST)
0pt|0n ~Parameter options (OPTIONS)
I~ Optional (*NOPASS) Optional (%OMIT)

I~ ariable size (*WARSIZE) I~ Mul-terminated string (*5TRING)

E | i * ™ Right adjusted string (*RIGHTADI) { >=v4R4)

IBM System i5 Tools | Remote System Exg poration

The procedure wizard can help with users not fully familiar with RPG IV, especially
for the parameters and return type information.
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Remote System Explorer

Integrated iSeries
Debugger

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

With the Integrated iSeries Debugger you can debug your program running on the
iSeries host from a graphical user interface on your workstation. You can also set
breakpoints before running the debugger, by inserting breakpoints directly in your
source while editing. The integrated iSeries debugger client user interface also
enables you to control program execution. For example, you can run your program,
set line, watch, and service entry point breakpoints, step through program
instructions, examine variables, and examine the call stack. You can also debug
multiple applications, which may be written in different languages, from a single
debugger window. Each session you debug is listed separately in the Debug view.
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Integrated iSeries Debugger - Overview

= Supports many languages

RPG, COBOL, CL, C, and C++
ILE and non ILE

Java

= Supports many views
Source and Listing

= Supports many applications
Batch and Job
Interactive
Multi-Threaded Applications
Client/Server Applications

Distributed Applications

i j I-*

‘ IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

The Integrated iSeries Debugger is powerful and complete.
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Debugger Invocation: from popup menus
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| IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

You can run and debug programs from the Remote Systems view or the iSeries
Table view in three ways:

*In a batch job
*In an interactive job
*In a server job

In the third case, running the program will use the same job as the Remote System
Explorer communications server job. With batch and interactive jobs, you cannot
monitor the status as easily, however, you do not tie up your communications server
and you are notified when the program command ends. Batch jobs work as you
would expect and do not require any initial setup.

Note: A multi-threaded debug session creates a new server job and this way keeps
the RSE communications server job free for other tasks.
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.
Debugger Configurations: for easy re-use!
4P Remote System Explorer - WebSphere De
Fie Edit Mavigate Search Project Rum  Window Create, manage, and run configurations
5-QE& Ge I - = -
ﬁ - Debug As »
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JLJ Script Host Application
B server [V stepinto
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@ websphere Applicatic™ Ll F
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| 3

1 I &, Existing debug configurations are easily 1o
3 Debua... accessible in debug pulldown!
IBM System i5 Tools | Remot Il = =

Cloj

Debug configurations are for powerful re-use. If what you want to debug takes a
number of parameters, or is not straightforward to launch, you can predefine this
information into a named configuration. Once created, the configuration appears in
the Debug configurations, and can be selected easily.
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Resume, Suspend, Terminate, Step Into,
Step Over, Step Return
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Row 64 Column 1 Replace Browse
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61 [E =
62 C
63 c Doy not *INED L
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65 [ *INKC IFEQ OFi0 Current
(13 C LEAVESE
Line
13 EZSR EDITSL
@ Break
Point . =
Debug Perspective =
= Praoperties . ’E E3 - X
ucperty [ vahie I v'Debug view
Call Level 13 . .
e 112 v'Source view (debug editor)
Library RSELABOL .
Moo PATROLLE v'"Numerous other views L
Proced... PAYROLLG
Program  PAYROLLG -
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Here we see the common Eclipse Debug perspective, which is being used to debug
an RPG program. The common debug user interface has been connected to the
iSeries debug engine in Version 5.0, to offer a common and compelling debug story
for OPM/ILE RPG and COBOL and CL, and ILE C and C++.

In the upper left pane is the call stack, much like option 11 in the OS/400’'s
WRKACTJOB. It shows the calls that reflect your current program execution. When
you double click an item in the stack, its source (if available) is shown in the source
pane in the middle. The upper right is where all the various views are for working
with data contents, breakpoints etc.. The middle is the debugger source view, with
source executable (debug) lines in blue, others in green. The current line of

execution is highlighted, and breakpoints appear as a dot with a check mark in the
left margin.

Although not part of the common Debug Perspective, the Properties view contains
valuable information about the selected object, which could be a breakpoint
selected in the Breakpoints view, an entry selected in the call stack, etc. To add the
Properties view, click on the menu item Window and Show View on the pull down
menu, select Other from the submenu , expand Basic, select Properties and click
OK.
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| IBM Software Group | WebSphere software

Setting Breakpoints
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tﬁ? Remote System Explorer - PAYROLL - WebSphere Development Studio Client Advanced Edition
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IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

This is the dialog for edit breakpoints. Enter the library name and select Program or
Service Program. The breakpoint is shown as a dot in the prefix area. If there is an
active debug session, the breakpoint will be set in that session and there will be no
marker in the editor. The breakpoint is then listed in the Breakpoints view in the
Debug perspective.
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Remote System Explorer

Designer

|.l4
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Now we’ll describe the CODE Designer tool, launchable from the IDE.

82



IBM Software Group | WebSphere software

H & R s
= Use Open With -> =
P . Bep o= m| =S
CODE Desi gner to = gl My Server Sl ] # Remats Systems LPEX Editor
H = ﬁjf‘eries Oh]ects. romse Wi 188 CODE Editor
Open DGSIgner x:;tx::: I;i;‘::: Rename + CODE Designer
— For DSPF, PRTF, t'\‘/hor:;u;itsl‘;memhers..‘ ;ﬂw
[+ User libraries
PF i‘:" My Lbrary 8 Delete
. =i, RSELABOL Ml best i
—_ LaunCheS 18] E] COMPARE. *file.pF Lrigwmmpt)
. =y QCRLLESRC Hfile. Compil R
Separate WIndOW E] QULIRC.file pf-5 Compile {Prompt) L4
% QMDSRC,“fie. o User fctions »
. =By ooossre e of
— Currently no built- e ——
. . Ly [ ke fivailable OFfine
in DDS Designer, D Moty e Rt One
. [y MSTDSP2.dspf  Compare With 4
but built-in source g
. oo RFRMST.OF
editor does support
DDS

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

CODE Designer is an editor like SDA and RLU, for WYSIWYG development of
display files and printer files. It also supports physical files.

Unlike the source editor, this editor has not been ported into the IDE yet, so those
wanting a great WYSIWYG tool have to use it still. To make that easy, there is a
right click action to launch it from a selected member.
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This is the CODE Designer. As you can see, because its not in the IDE, it launches
in its own main window.
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CODE Designer

= Graphical design tool for DDS
display files - screens

printer files - reports
physical files - databases

= Powerful intuitive interface

Lets novice create DDS quickly and easily while giving
expert access to all the features of DDS

WYSIWYG graphical design - Drag/drop ease
Properties notebook

Integrated local verifier

Explorer-like browsing of DDS hierarchy

1-]
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CODE Designer is a very popular and powerful tool.
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This is the equivalent of SDA’s option 12 design screen. It is rich in toolbar and
palette items, and supports drag and drop, and direct editing.
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For those who prefer non-WYSIWYG, there is also a field list where you can create,
change and re-order fields. It contents changes as records are selected in the DDS
Explorer primary view on the left. The field list is the only option for PF editing.
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Remote System Explorer

Reference
information

¥ |

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation
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Getting Service Packs and Verifying
PTFs

= To get client service packs from web:

Use Help->Software Updates->IBM Rational
Product Updater

Repeat until told no new updates

= To verify you have all required host PTFs:

On an iSeries connection, right click on
iISeries Objects subsystem

Select Verify Connection

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

Please try the RSE! And to ensure success, we want to ensure you have the latest
client and server fixes.
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Additional Information
*homepage:

http://www.ibm.com/software/awdtools/wdt400/

"newsgroup:
news://news.software.ibm.com/ibm.software.
websphere.code400

= \WDSC 6.0.1 Announcement Letter

http://www-306.ibm.com/common/ssi/fcgi-
bin/ssialias?infotype=an&subtype=ca&appname=Demonstration&htmlfid=897/ENUS206-021

= email distribution list:

To post a message email: WDSCI-L@midrange.com

To subscribe, unsubscribe, or change list options,
visit: http://lists.midrange.com/mailman/listinfo/wdsci-|
or email: WDSCI-L-request@midrange.com

Before posting, please take a moment to review the archives
at "

IBM System i5 Tools | Remote System Explorer | © 2004 2006 IBM Corporation

We hope this presentation helped you understand more about Development Studio
Client iSeries application development tools. We started with an overview of our
strategy for iSeries application development tools, went onto review the Remote
System Explorer, the perspective for iSeries programmers to maintain and develop

iSeries applications and explained how to extend RSE to include your own iSeries
application development tools.
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